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Preface 
 

The objective of all engineering laboratories or field experience in the technical education system 

is to help students acquire the critical competencies and skills that businesses demand. In light of this, 

MSBTE developed the cutting-edge “K” Scheme curricula for engineering diploma programs, 

emphasizing outcome-based learning and the National Education Policy 2020 (NEP2020). As a result, 

a sizable portion of the program is dedicated to practical work. This demonstrates how crucial laboratory 

work is in helping teachers, instructors, and students understand that every minute of lab time must be 

used efficiently to create these outcomes rather than being spent on pointless tasks. Consequently, each 

practical has been created to operate as a “vehicle” to advance this industry in order to ensure the 

successful implementation of this outcome-based curriculum. It is challenging to teach practical skills 

using only the “chalk and duster” activity. Because of this, the “K” scheme laboratory manual creation 

team focused on the outcomes when designing the practical rather than following the long-standing 

custom of doing the practical to “verify the theory” (which may turn out to be a by-product along the 

way). 

This lab manual is intended to support all parties involved, particularly the students, instructors, 

and teachers, in helping the students achieve the pre-established objectives. It is required of every student 

to read through the relevant practical process in its entirety and comprehend the bare minimum of 

theoretical background related to the practical at least one day in advance of the practical. As a crucial 

starting point for carrying out the practical, each exercise in this manual starts with establishing the 

competency, industry-relevant skills, course outcomes, and practical outcomes. The skills, the students 

will acquire from the process outlined there, together with the necessary safety measures to be followed, 

will subsequently be made clear to them. These will enable them to apply the knowledge and abilities to 

solve real-world problems in their professional lives. 

In today’s data-driven world, cloud computing provides scalable, cost-effective solutions for 

managing and analysing large datasets. Cloud platforms like Amazon Web Services (AWS) offer robust 

tools such as Amazon SageMaker to streamline the machine learning workflow, from data preparation 

and model training to deployment and validation. 

This practical exercise guides students in leveraging cloud resources to build, train, and deploy 

machine learning models. It provides hands-on experience with real-world data, ensuring a deep 

understanding of both theoretical concepts and practical implementation in a modern cloud-based 

environment. 

The team responsible for developing the Practical manual would like to express its gratitude to 

MSBTE for taking the lead in developing and implementing the curriculum. Additionally, the team 

recognizes the valuable contributions made by individual course experts who have been directly or 

indirectly involved in the development of the “K” scheme curriculum and the laboratory manual. It is 

impossible to claim perfection in this laboratory manual, even though every effort has been made to 

verify it for errors, especially because this is the first edition. Any such mistakes and recommendations 

for enhancements are quite appreciated and can be brought to our attention. 

 

Lab Manual Development Team 
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        Program Outcomes (POs) to be achieved through Practical of this Course 

 

Following POs are expected to be achieved through the practical’s of the Cloud computing course. 

 

PO1. Basic and Discipline specific knowledge: Apply knowledge of basic mathematics, science 

and engineering fundamentals and engineering specialization to solve the engineering 

problems.    

PO 2. Problem analysis: Identify and analyze well-defined engineering problems using codified 

standard methods.    

PO 3. Design/ development of solutions: Design solutions for well-defined technical problems 

and assist with the design of systems components or processes to meet specified needs.   

PO 4. Engineering Tools, Experimentation and Testing: Apply modern engineering tools and 

appropriate technique to conduct standard tests and measurements.    

PO 5. Engineering practices for society, sustainability and environment: Apply appropriate 

technology in context of society, sustainability, environment and ethical practices.    

PO 6. Project Management: Use engineering management principles individually, as a team 

member or a leader to manage projects and effectively communicate about well-defined 

engineering activities in diverse and multidisciplinary fields.   

PO 7. Life-long learning: Ability to analyze individual needs and engage in updating in the 

context of technological changes. 

 
 

      List of Industry Relevant Skills: 

 
        The following industry relevant skills of the competency ‘Cloud Computing’ are expected to be           

        developed in you by undertaking the practical of this laboratory manual. 

 Cloud Platforms  

 Data Management 

 Machine Learning & Model Deployment 

 Scalable Computing 

 Security & IAM 

 
 

 

 

 
 

 

 
 

  



Cloud Computing (315325) 
  

Maharashtra State Board of Technical Education-K Scheme                                                                           III 

 

 

Practical- Course Outcome (CO) matrix 
CO1 - Use basic Cloud based applications. 

CO2 - Explain Virtualization in Cloud Computing. 

CO3 - Maintain storage system and services in Cloud. 

CO4 - Apply Security in Cloud Computing. 

CO5 - Use various Cloud Platforms. 

 

Sr. 
No. 

Title of the Practical 
CO 

1. 

CO 

2. 

CO 

3. 

CO 

4. 

CO 

5. 

1 * Configure Cloud using JustCloud √ - - - - 

2 
Use Goggle Doc to make spreadsheet and 
notes 

√ 
- - - - 

3 
* Create Virtual Machines using VMware 
(Private Cloud) and delete the created 
VM after completion 

-  

√ 
 

- 

 

- 

 

- 

4 
* Implement Storage Service on Cloud using 

OpenStack 

- √ 
- - - 

5 
* Create and Host Simple Web Application 

on Google cloud/Any cloud platform 

- - 
√ 

- - 

6  Create a File System using HDFS 
- 

- 
√ 

- - 

 

7 
Work in Codenvy to show Provisioning and 
Scaling of a website 

- - √ 
- - 

8 
* Implement Identity Management and 
Access Management using OpenStack 

- - √ - - 

9 
Configure Server using CFEngine or any 
other open source tool 

- - √ 

- - 

10 
* Design an application based on IoT using 
Arduino or Raspberry Pi 

- - 
- - √ 

11 
Design any automated application using 

RFID 

- - 
- 

- √ 
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Guidelines to Teachers 

1. There will be two sheets of blank pages after every practical for the student to report other matters (if 

any), which is not mentioned in the printed practical. 

2. For difficult practical if required, teacher could provide the demonstration of the practical 

emphasizing of the skills which the student should achieve. 

3. Teachers should give opportunity to students for hands-on after the demonstration. 

4. Assess the skill achievement of the students and COs of each unit. 

5. One or two questions ought to be added in each practical for different batches. For this teacher can 

maintain various practical related question banks for each course. 

6. For effective implementation and attainment of practical outcomes, teacher ought to ensure that in 

the beginning itself of each practical, students must read through the complete write-up of that practical 

sheet. 

7. During practical, ensure that each student gets chance and takes active part in taking observations/ 

readings and performing practical. 

8. Teacher ought to assess the performance of students continuously according to the   MSBTE 

guidelines. 

 

Instructions for Students 
 

1. For incidental writing on the day of each practical session every student should maintain a dated log 

book for the whole semester, apart from this laboratory manual which s/he has to submit for assessment 

to the teacher in the next practical session. 

2. For effective implementation and attainment of practical outcomes, in the beginning itself of each 

practical, students need to read through the complete write-up including the practical related questions 

and assessment scheme of that practical sheet. 

3. Student ought to refer the reference book, lab manuals etc. Student should not hesitate to ask any 

difficulties they face during the conduct of practical’s. 
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Content Page 

 
List of Practical and Progressive Assessment Sheet 

 
 

S. No Laboratory Practical Titles 
Page 

No. 

Date of 

performance 

Date of 

submission 

FA PR 

marks 

(25) 

Dated 

sign. of 

teacher 

Remarks  

(if any) 

1 * Configure Cloud using JustCloud 11    1      

2 
a) Use Goggle Doc to make 
spreadsheet and notes 

5  
  

 
 

3 

a) * Create Virtual Machines using 
VMware (Private Cloud) and delete 
the created VM after completion 

9  
  

 
 

4 
* Implement Storage Service on 
Cloud using OpenStack 

13  
  

 
 

5 

* Create and Host Simple Web 

Application on Google cloud/Any 

cloud platform 

17  
  

 
 

6  Create a File System using HDFS 21  
  

 
 

7 
Work in Codenvy to show 

Provisioning and Scaling of a website 
25  

  
 

 

8 

* Implement Identity Management 
and Access Management using 
OpenStack 

28  
  

 
 

9 
Configure Server using CFEngine or 
any other open source tool 

31 
   

 
 

10 

 

* Design an application based on IoT 
using Arduino or Raspberry Pi 

34 
   

 
 

11 
Design any automated application 
using RFID 

38 
   

 
 

Total 
 

 
 

 

 

Note: To be transferred to Proforma of CIAAN-2023. 

Note : Out of above suggestive LLOs - 

 '*' Marked Practical’s (LLOs) Are mandatory. 

 Minimum 80% of above list of lab experiment are to be performed. 

 Judicial mix of LLOs are to be performed to achieve desired outcomes. 
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Practical No. 1: Configure Cloud using JustCloud 
 

I Practical Significance 
The practical value of cloud computing is that it enables the delivery of adaptable, 

affordable, and scalable computing resources via the internet. It gives individuals and 

businesses the ability to use data, apps, and services from any location at any time, 

facilitating increased mobility and remote cooperation.  

 

II Industry/Employer Expected outcome(s) 

   Manage Cloud based services. 

 

III Course Level Learning outcome(s) 
CO1 - Use basic Cloud based applications. 

IV Laboratory Learning outcome(s) 

            LLO 1.1 Configure Cloud storage. 

 

V Relevant Affective Domain Related Outcomes 

Demonstrates the Role of Cloud in Modern IT. 

 

VI       Relevant Theoretical Background 
A fundamental grasp of cloud computing principles, such as the function of cloud 

storage and the distinction between cloud-based and local data storage, is the minimum 

theoretical foundation needed to set up cloud storage using JustCloud. The significance 

of internet access for downloading and uploading files to the cloud, as well as the 

concepts of data backup, synchronization, and restoration, should be understood by 

users. It's also crucial to have a basic understanding of the files and directories that 

make up an operating system since users must choose the precise data they want to 

backup. Furthermore, a basic understanding of cloud security, such as the usage of 

strong passwords and the significance of account authentication, is helpful. Generally 

speaking, setting up JustCloud only requires a basic understanding of internet access, 

computer use, and data management concepts; no sophisticated IT expertise is 

necessary. 

Step 1: 

1. Log in to Your Bluehost India Control Panel. 

2. Navigate to Bluehost India. 

3. Click on the "Control Panel Login" button located at the top-right corner. 

4. Enter your username (email or domain name) and password, then click Login. 

Step 2:  

            Access the Advanced (cPanel) Features 

1. Once logged in, locate the Advanced tab in the left-hand navigation menu. 

2. Click on Advanced to access the cPanel interface, which provides advanced 

tools for managing your hosting account. 

Step 3:  

           Set Up Your Website 

1. In the Advanced section, scroll down to the Software section. 

2. Click on WordPress Manager or Softaculous Apps Installer. 
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3. Select WordPress and click Install. 

4. Fill in the required details, such as site name, description, admin username, and 

password. 

5. Choose the domain where you want to install WordPress. 

6. Click Install to begin the installation process. 

Step 4:  

Manage Files and Databases 

1. File Manager: Access the File Manager under the Files section to upload, edit, 

or delete website files. 

2. MySQL Databases: Under the Databases section, use MySQL Databases to 

create and manage databases for your applications. 

Step 5:  

Set Up Email Accounts 

1. In the Advanced section, scroll down to the Email section. 

2. Click on Email Accounts. 

3. Click Create to set up a new email account associated with your domain. 

4. Fill in the necessary details and set a password. 

5. Click Create Account. 

Step 6: 

Secure Your Website with SSL 

1. In the Advanced section, navigate to the Security section. 

2. Click on SSL/TLS. 

3. Use the Manage SSL Sites option to install or manage SSL certificates for your 

domains. 

Step 7:  

Manage Domains and DNS 

1. Click on the Domains tab in the main navigation menu. 

2. Here, you can register new domains, assign domains to your account, or manage 

existing ones. 

3. To modify DNS records, go to the Advanced section and click on Zone Editor 

under the Domains section. 

4. Use the Zone Editor to add or edit DNS records like A, CNAME, and MX 

records. BluehostBluehost+1Bluehost+1Bluehost 

Step 8:  

Utilize Additional Tools 

1. SSH Access: For secure remote access, set up SSH keys under the Security 

section.  

2. Backup: Use the Backup tool under the Files section to create or restore backups 

of your website. 

3. Cron Jobs: Automate tasks by setting up cron jobs under the Advanced section. 
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VII Resources required (Additional) 

 

Sr. 

No. 

Name of Resource Specification Quantity Remarks 

(If any) 

1. Cloud Service 

Provider 

AWS / Azure / Google 

Cloud / DigitalOcean / 

Bluehost 

1 Account 

 

For ALL 

Experiments 

2. Storage Type Object Storage (e.g., 

AWS S3), Block Storage 

(e.g., EBS), or File 

Storage 

1 1 Service 

 

3. Internet 

Connectivity 

Minimum 10 Mbps 

stable connection for 

upload/download 

1 Connection 

 

 

VIII Precautions to be followed 

 1. Follow precautionary measures. 

       2. Follow naming conventions. 

       3. Follow ethical practices. 

 

             IX   Conclusion 

 

…………………………………………………………………………………………………

…………………………………………………………………………………………………

…………………………………………………………………………………………………

………………………………………………………………………………………………… 

………………………………………………………………………………………………… 

 

              X    Practical related Questions 

        Note: Below given are few sample questions for reference. Teachers must design more   

                 such questions to ensure the achievement of identified CO. 
1. Create a cloud storage bucket using your chosen cloud provider (AWS/GCP/Azure/Bluehost). 

Document the steps with screenshots. 

2. Upload a file (PDF/image/text) to the cloud storage bucket. 

3. Write a short script (in Python/Node.js) to upload and download files from the configured 

cloud storage. 

    

(Space for Answer) 

…………………………………………………………………………………………………

…………………………………………………………………………………………………

…………………………………………………………………………………………………

…………………………………………………………………………………………………

…………………………………………………………………………………………………

…………………………………………………………………………………………………
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………………………………………………………………………………………………… 

…………………………………………………………………………………………………

…………………………………………………………………………………………………

…………………………………………………………………………………………………

………………………………………………………………………………………………… 

…………………………………………………………………………………………………

…………………………………………………………………………………………………

…………………………………………………………………………………………………

………………………………………………………………………………………………… 

…………………………………………………………………………………………………

…………………………………………………………………………………………………

…………………………………………………………………………………………………

………………………………………………………………………………………………… 

…………………………………………………………………………………………………

…………………………………………………………………………………………………

…………………………………………………………………………………………………

………………………………………………………………………………………………… 

 

 

            XI References / Suggestions for further Reading 

1. https://www.justcloud.com/ 

2. https://learn.microsoft.com/en-us/azure/storage/blobs/ 

3. https://docs.aws.amazon.com/s3/ 

 

XII Assessment Scheme 

            The given performance indicators should serve as a guideline for assessment 

regarding process and product related marks. Faculty must fill only the table at 

bottom. 

 

Performance indicators Weightage 

Process related (15 Marks) 70% 

1  Logic formation 30% 

2  Debugging ability 30% 

3  Follow ethical practices 10% 

Product related (10 Marks) 30% 

4  Expected output 10% 

5  Timely Submission 10% 

6  Answer to sample questions 10% 

 Total (25 Marks) 100% 

 

 

  

              

 

 

 

  

 

Marks Obtained 
Dated signature of 

Teacher 

Process 

Related(15) 

Product 

Related(10) 

Total 

(25)  

   

https://www.justcloud.com/
https://learn.microsoft.com/en-us/azure/storage/blobs/
https://docs.aws.amazon.com/s3/
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Practical No. 2: Use Goggle Doc to make spreadsheet and notes    

 

I      Practical Significance 
Google Docs and Google Sheets are cloud-based programs, users may create, modify, 

and share documents and spreadsheets in real-time from any device with an internet 

connection. Particularly useful for students, researchers, and professionals who must 

record observations, keep records, analyse data, or take organized notes.  

 

II Industry/Employer Expected outcome(s) 
  Manage Cloud based services. 
 

III Course Level Learning outcome(s) 
CO1-Use basic Cloud based applications. 

IV Laboratory Learning outcome(s) 
            LLO 2.1 Create document for given application. 

 

V Relevant Affective Domain Related Outcomes 
These outcomes focus on the values, attitudes, and interpersonal skills developed during 

this digital productivity task. 

 

VI       Relevant Theoretical Background 

 

            To use Google Docs and Google Sheets for spreadsheet and note creation, one must 

have at least a fundamental understanding of digital literacy and standard office 

software. Users should be comfortable with basic computer skills like utilizing a 

keyboard and mouse, navigating web browsers, and managing files and folders. 

Having a basic understanding of text formatting, such as using bold, italics, and 

headings, is beneficial for taking notes well in Google Docs. In the same way, knowing 

the fundamentals of spreadsheets, such as rows, columns, cells, and simple formulas 

(e. g.  addition, averaging), is essential for maximizing your use of Google Sheets. 

Additionally, it's crucial to comprehend how cloud storage operates, notably the 

notion of storing data online and being able to retrieve it from various devices. With 

this fundamental understanding, users may efficiently generate, modify, save, and 

share spreadsheets and documents in a cloud-based platform. 

 

A. Steps to Create Notes Using Google Docs: 

 Go to Google Docs 

Visit https://docs.google.com and sign in with your Google account. 

 Start a New Document 

Click on “Blank” or select a template to begin. 

 Rename the Document 

Click on “Untitled document” at the top-left and enter a meaningful name. 

 Type and Format Notes 

Use headings, bullet points, numbering, and formatting tools to organize your 

notes. 

 Insert Additional Elements (Optional) 

Add images, tables, charts, or links via the Insert menu. 

https://docs.google.com/


Cloud Computing                                       Course Code: 315325 

 

6 
Maharashtra State Board of Technical Education-K Scheme 

 Save and Share (Optional) 

Docs auto-save automatically. To share, click the “Share” button and set 

permissions. 

B. Steps to Create a Spreadsheet Using Google Sheets: 

 Go to Google Sheets 

Visit https://sheets.google.com. 

 Start a New Spreadsheet 

Click on “Blank” to open a new sheet. 

 Rename the Spreadsheet 

Click on “Untitled spreadsheet” and enter a name. 

 Enter and Organize Data 

Input your data in rows and columns. Use formatting tools for clarity. 

 Use Formulas and Functions (Optional) 

Apply basic formulas like =SUM(), =AVERAGE() to process data. 

 Insert Charts or Graphs (Optional) 

Use Insert > Chart to visualize data. 

 Save and Share (Optional) 

Sheets auto-save automatically. Click “Share” to collaborate. 

C. Link Sheets with Docs: 

 In Google Docs, go to Insert > Chart > From Sheets. 

 Select the spreadsheet and choose the chart to embed. 

 Alternatively, copy and paste a link to the spreadsheet into your notes. 
 

VII Resources required (Additional) 
Sr. 

No. 

Name of Resource Specificatio

n 

Quantity Remarks 

(If any) 

1. Google Docs Online word 

processor 

             1 

 

For all 

experiments. 

2. Google Sheets Online spreadsheet 

tool 

             1 

 

 

VIII Precautions to be followed 
 1. Follow precautionary measures. 

       2. Follow naming conventions. 

       3. Follow ethical practices. 

 

 

             IX   Conclusion 

         ……………………………………………………………………………………   

……………………………………………………………………………………

…………………………………………………………………………………… 

 

……………………………………………………………………………………

…………………………………………………………………………………… 

https://sheets.google.com/
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            X    Practical related Questions 
        Note: Below given are few sample questions for reference. Teachers must design more      

                 such questions to ensure the achievement of identified CO. 
1. Create a Google Doc titled "Weekly Study Notes". Add three headings: 

Math, Science, and English. Under each heading, add at least 3 bullet points 

summarizing what you learned. 

2. Create a spreadsheet titled "Monthly Expense Tracker". Include columns: 

Date, Item, Category, Amount. Add at least 5 rows of sample data. 

3. Create a folder in Google Drive called “Class Work” and move both files into 

it. 

(Space for Answer) 

……………………………………………………………………………………

……………………………………………………………………………………

……………………………………………………………………………………

……………………………………………………………………………………

……………………………………………………………………………………

…………………………………………………………………………………… 

……………………………………………………………………………………

……………………………………………………………………………………

…………………………………………………………………………………… 

……………………………………………………………………………………

……………………………………………………………………………………

…………………………………………………………………………………… 

……………………………………………………………………………………

……………………………………………………………………………………

…………………………………………………………………………………… 

……………………………………………………………………………………

……………………………………………………………………………………

…………………………………………………………………………………… 

……………………………………………………………………………………

……………………………………………………………………………………

…………………………………………………………………………………… 

……………………………………………………………………………………

……………………………………………………………………………………

…………………………………………………………………………………… 

……………………………………………………………………………………

…………………………………………………………………………………… 

……………………………………………………………………………………

…………………………………………………………………………………… 

……………………………………………………………………………………

…………………………………………………………………………………… 

…………………………………………………………………………………… 
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…………………………………………………………………………………… 

……………………………………………………………………………………

…………………………………………………………………………………… 

……………………………………………………………………………………

…………………………………………………………………………………… 

……………………………………………………………………………………

…………………………………………………………………………………… 

……………………………………………………………………………………

…………………………………………………………………………………… 

……………………………………………………………………………………

…………………………………………………………………………………… 

……………………………………………………………………………………

…………………………………………………………………………………… 

 

           XI References / Suggestions for further Reading 
1. https://edu.gcfglobal.org/en/googledocuments/  

2. https://www.khanacademy.org 

 

          XII Assessment Scheme 
          The given performance indicators should serve as a guideline for assessment regarding 

process and product related marks. Faculty must fill only the table at bottom. 

 

Performance indicators Weightage 

Process related (15 Marks) 70% 

1  Logic formation 30% 

2  Debugging ability 30% 

3  Follow ethical practices 10% 

Product related (10 Marks) 30% 

4  Expected output 10% 

5  Timely Submission 10% 

6  Answer to sample questions 10% 

 Total (25 Marks) 100% 

 

 

 

  

              

 

 

 

  

  

 

Marks Obtained 
Dated signature of 

Teacher 

Process 

Related(15) 

Product 

Related(10) 

Total 

(25) 
 

   

https://edu.gcfglobal.org/en/googledocuments/
https://www.khanacademy.org/
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Practical No. 3: Create Virtual Machines using VMware (Private Cloud) 

and delete the created VM after completion 

 

I       Practical Significance 
Creating and deleting VMs using VMware in a Private Cloud enables efficient, 

secure, and on-demand use of resources for testing, development, or training. It 

ensures optimal resource utilization and maintains a clean environment post-

completion. 

 

II Industry/Employer Expected outcome(s) 

Manage Cloud based services. 
 

III Course Level Learning outcome(s) 
CO2 - Explain Virtualization in Cloud Computing. 

IV Laboratory Learning outcome(s) 
            LLO 3.1 Create virtual environment. 

 

V Relevant Affective Domain Related Outcomes 

Demonstrates responsibility and discipline in managing virtual resources efficiently and 

ethically within a private cloud environment. 

 

VI       Relevant Theoretical Background 
           A fundamental grasp of a few essential theoretical concepts is necessary in order to 

successfully develop and administer virtual machines (VMs) using VMware in a 

private cloud environment. First, users need to understand the basics of virtualization, 

such as what a virtual machine is, how it functions, and the purpose of a hypervisor 

like VMware Workstation. To comprehend the extent of resource management, 

security, and scalability, it is also necessary to understand private cloud infrastructure 

and how it differs from public and hybrid clouds. 

            Additionally, in order to allocate the necessary resources when creating a VM, one 

must have a fundamental knowledge of computer hardware components like the CPU, 

RAM, disk storage, and network interfaces. Users should be comfortable with basic 

setup and installing operating systems like Windows or Linux. In the end, knowing 

about file systems, virtual machine snapshots, and virtual storage can help you manage 

and eventually remove virtual machines securely without harming the host system. 

This basic knowledge guarantees that VMware will be used effectively and without 

errors for virtualization activities in a private cloud environment, even though no in-

depth understanding is necessary. 

 

Steps to Create a Virtual Machine Using VMware (Private Cloud) 

1. Log in to VMware platform 

            Open VMware vSphere Client or VMware Workstation, and log in with your 

credentials. 

2. Start the VM creation wizard 

Click on “Create New Virtual Machine” or similar option. 

3. Choose the configuration type 

            Select Typical (recommended) for simple setup or Custom for advanced 

options. 
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4. Name your VM and select storage location 

Enter a name for the VM and choose where the VM files will be stored in your datastore. 

5. Select the guest operating system 

Choose the OS type (Windows, Linux, etc.) and version you want to install. 

6. Assign hardware resources 

Allocate CPU cores, RAM size, disk space, and network adapter settings. 

7. Attach installation media 

Mount an ISO image or connect a physical installation disk for the OS. 

8. Review and finish 

Review the settings and click Finish to create the VM. 

9. Power on the VM 

Start the VM and proceed with the operating system installation. 

 

                 Steps to Delete the Created Virtual Machine 

1. Shut down the VM 

Properly power off the VM from within the guest OS or through VMware controls. 

2. Remove VM from inventory 

In VMware vSphere: Right-click the VM and choose “Remove from Inventory”. 

3. Delete VM files 

Select the option “Delete from Disk” to permanently remove VM files and free up 

storage. 

4. Confirm deletion 

Verify that the VM is no longer listed and that associated files have been removed from 

storage. 

 

 

VII Resources required (Additional) 
 

Sr. 

No. 

Name of Resource Specificati

on 

Quantity Remarks 

(If any) 

1. Host Computer / 

Server 

Intel i5/i7 or Xeon 

processor, 16 GB+ 

RAM, 500 GB+ 

SSD, 

virtualization-

enabled BIOS 

1  

 

For ALL 

Experiments 

2. VMware Software VMware 

Workstation Pro / 

VMware ESXi / 

vSphere 

             1 

 

 

 

VIII Precautions to be followed 

 1. Follow precautionary measures. 

       2. Follow naming conventions. 

       3. Follow ethical practices. 
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          IX   Conclusion 

…………………………………………………………………………………………………  

…………………………………………………………………………………………………

………………………………………………………………………………………………… 

 

          X    Practical related Questions 

        Note: Below given are few sample questions for reference. Teachers must design more           

                  such questions to ensure the achievement of identified CO. 

1. Create a virtual machine using VMware Workstation or vSphere with the following 

specifications: OS: Ubuntu/Linux/Windows (choose one), RAM: 4 GB, CPU: 2 cores. 

Disk: 40 GB 

2.  Install the selected operating system on the VM using an ISO image. 

3. Change the VM settings to increase the RAM to 6 GB. Note the effect. 

4. Remove the VM from inventory without deleting its files. Then re-add it to the 

inventory. 

 

   

(Space for Answer) 

…………………………………………………………………………………………………

…………………………………………………………………………………………………

…………………………………………………………………………………………………

…………………………………………………………………………………………………

…………………………………………………………………………………………………

…………………………………………………………………………………………………

…………………………………………………………………………………………………

…………………………………………………………………………………………………

…………………………………………………………………………………………………

…………………………………………………………………………………………………

…………………………………………………………………………………………………

…………………………………………………………………………………………………

…………………………………………………………………………………………………

…………………………………………………………………………………………………

…………………………………………………………………………………………………

…………………………………………………………………………………………………

…………………………………………………………………………………………………

…………………………………………………………………………………………………

…………………………………………………………………………………………………

…………………………………………………………………………………………………

………………………………………………………………………………………………… 

…………………………………………………………………………………………………

………………………………………………………………………………………………… 

………………………………………………………………………………………………… 

…………………………………………………………………………………………………

…………………………………………………………………………………………………

………………………………………………………………………………………………… 

…………………………………………………………………………………………………

………………………………………………………………………………………………… 

………………………………………………………………………………………………… 

 



Cloud Computing                                       Course Code: 315325 

 

12 
Maharashtra State Board of Technical Education-K Scheme 

              XI References / Suggestions for further Reading 

1. https://docs.vmware.com 

2. https://docs.vmware.com/en/VMware-Workstation-Pro/index.html 

3. https://www.youtube.com/watch?v=BHpRTVP8upg 

4. https://youtu.be/LkdvyTuFpY0 

 

 

XII Assessment Scheme 

         The given performance indicators should serve as a guideline for assessment regarding 

process and product related marks. Faculty must fill only the table at bottom. 

 

Performance indicators Weightage 

Process related (15 Marks)            70% 

1  Logic formation 30% 

2  Debugging ability 30% 

3  Follow ethical practices 10% 

Product related (10 Marks) 30% 

4  Expected output 10% 

5  Timely Submission 10% 

6  Answer to sample questions 10% 

 Total (25 Marks) 100% 

 

 

 

 

 

 

  

              

 

 

 

  

  

 

 

 

 

 

 

 

 

 

 

 

 

  

Marks Obtained 
Dated signature of 

Teacher 

Process 

Related(15) 

Product 

Related(10) 

Total 

(25) 
 

   

https://docs.vmware.com/
https://docs.vmware.com/en/VMware-Workstation-Pro/index.html
https://www.youtube.com/watch?v=BHpRTVP8upg
https://youtu.be/LkdvyTuFpY0
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Practical No. 4: Implement Storage Service on Cloud using OpenStack 

 
I          Practical Significance 

Implementing storage service on cloud using OpenStack enables scalable, cost-

effective, and flexible data storage management. It ensures high availability and easy 

integration with other cloud services for seamless operations. 

 

II        Industry/Employer Expected outcome(s)  

  Manage Cloud based services. 

 

III        Course Level Learning outcome(s) 

CO3- Maintain storage system and services in Cloud. 

IV        Laboratory Learning outcome(s) 

            LLO 4.1 Implement storage service on Cloud. 

 

V         Relevant Affective Domain Related Outcomes 

Demonstrates responsibility and willingness to adopt cloud-based storage solutions 

while appreciating their role in enhancing data accessibility and efficiency. 

 

VI      Relevant Theoretical Background 
Learners must have basic understanding in a few essential topics in order to utilize 

OpenStack to deliver cloud storage services. This involves comprehending the 

distinctions between block storage and object storage, as well as cloud computing 

models (particularly Infrastructure as a Service, or IaaS). It is imperative to have a 

fundamental understanding of the architecture of OpenStack and its fundamental 

elements, notably Cinder (for block storage) and Swift (for object storage). In addition, 

a strong understanding of networking principles, such as IP addressing and storage 

protocols like iSCSI or NFS, as well as Linux operating system commands and 

virtualization concepts will aid in successful setup and maintenance. Familiarity with 

storage lifecycle management, APIs, and client-server architecture enhances value at 

the novice level, although it is not required. 

Steps to Implement Storage Service on Cloud Using OpenStack 

a. Prerequisites 

 A working OpenStack environment (e.g., installed via DevStack, 

Packstack, or manually). 

 Root or admin access to the OpenStack dashboard (Horizon) and CLI. 

 Sufficient compute and storage resources on the host machine. 

b. Steps to Configure Block Storage (Cinder) 

 Install and Configure Cinder Service 

 Install openstack -cinder packages on the controller node and 

storage node. 

 Configure /etc/cinder/cinder.conf with correct database, 

message queue, and authentication settings. 

 Create Cinder Database and User 

 Create a Cinder database in MariaDB/MySQL. 

 Add Cinder user and assign it the admin role. 

 Register Cinder with Identity Service (Keystone) 
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 Create a service entry for Cinder in Keystone. 

 Add API endpoints (public, internal, admin) for Cinder. 

 Start Cinder Services 

 Enable and start cinder-api, cinder-scheduler, and cinder-

volume. 

 Add and Manage Block Storage Volumes 

 Use OpenStack CLI or Horizon to create and attach volumes to 

instances. 

 Monitor volume status, attach/detach operations, and snapshots. 

c. Steps to Configure Object Storage (Swift) 

 Install and Configure Swift 

 Install Swift packages: openstack-swift, swift-account, swift-

container, swift-object. 

 Set up ring files (account, container, object) using swift-ring-

builder. 

 Create Swift User and Endpoint. 

 Add a Swift user in Keystone and register service and endpoints. 

 Configure Storage Node 

 Format and mount storage disks. 

 Configure rsync, account-server.conf, container-server.conf, and 

object-server.conf. 

 Start Swift Services 

 Start the Swift proxy and storage node services. 

 Upload and Access Objects 

 Use OpenStack Horizon or CLI to create containers and upload 

files. 

 Access objects using URLs or APIs. 

d. Verification and Testing 

 Create instances and attach Cinder volumes. 

 Upload/download files to Swift containers. 

 Monitor storage usage and logs for errors. 

 

VII     Resources required (Additional) 
 

Sr. 

No. 

Name of Resource Specification Quantity Remarks 

(If any) 

1. Server Machine 

(Controller Node) 

CPU: Quad-Core, 

RAM: 16 GB, Storage: 

250 GB SSD 

1  

 

s 

2. Server Machine 

(Storage Node) 

CPU: Quad-Core, 

RAM: 16 GB, Storage: 

500 GB+ HDD/SSD 

             1 

 

VIII  Precautions to be followed 
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  1. Follow precautionary measures. 

        2. Follow naming conventions. 

        3. Follow ethical practices. 

 

IX   Conclusion 

………………………………………………………………………………………………..  

…………………………………………………………………………………………………

………………………………………………………………………………………………… 

 

X    Practical related Questions 

        Note: Below given are few sample questions for reference. Teachers must design more                

                  such questions to ensure the achievement of identified CO. 

1. Create and manage a block storage volume using OpenStack CLI and dashboard. 

2. Attach a Cinder volume to a running virtual machine instance. 

3. Detach and delete a block storage volume from an instance. 

 

(Space for Answer) 

…………………………………………………………………………………………………
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…………………………………………………………………………………………………

…………………………………………………………………………………………………

…………………………………………………………………………………………………

…………………………………………………………………………………………………

…………………………………………………………………………………………………

…………………………………………………………………………………………………
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…………………………………………………………………………………………………

…………………………………………………………………………………………………

…………………………………………………………………………………………………

…………………………………………………………………………………………………

…………………………………………………………………………………………………

…………………………………………………………………………………………………

…………………………………………………………………………………………………

…………………………………………………………………………………………………

…………………………………………………………………………………………………

…………………………………………………………………………………………………

…………………………………………………………………………………………………

…………………………………………………………………………………………………

…………………………………………………………………………………………………

………………………………………………………………………………………………… 

…………………………………………………………………………………………………

…………………………………………………………………………………………………        
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             XI References / Suggestions for further Reading 

1. https://docs.openstack.org/cinder/latest/ 

2. https://docs.openstack.org/install/ 

3. https://youtu.be/vhYvtIl7Byc 

 

XII Assessment Scheme 

        The given performance indicators should serve as a guideline for assessment regarding 

process and product related marks. Faculty must fill only the table at bottom. 

 

Performance indicators Weightage 

Process related (15 Marks) 70% 

1  Logic formation 30% 

2  Debugging ability 30% 

3  Follow ethical practices 10% 

Product related (10 Marks) 30% 

4  Expected output 10% 

5  Timely Submission 10% 

6  Answer to sample questions 10% 

 Total (25 Marks) 100% 

 

 

 

 

 

  

              

 

 

 

  

  

 

 

 

 

 

 

 

  

Marks Obtained 
Dated signature of 

Teacher 

Process 

Related(15) 

Product 

Related(10) 

Total 

(25) 
 

   

https://docs.openstack.org/cinder/latest/
https://docs.openstack.org/install/
https://youtu.be/vhYvtIl7Byc
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Practical No. 5: Create and Host Simple Web Application on Google 

cloud/Any cloud platform 

 

I       Practical Significance 

Creating and hosting a simple web application on Google Cloud or any cloud platform 

provides hands-on experience with cloud deployment and scalability. It enables 

students to understand real-world application hosting, resource management, and cost-

effective cloud usage. 

 

II Industry/Employer Expected outcome(s) 
  Manage Cloud based services. 

 

III Course Level Learning outcome(s) 

CO3- Maintain storage system and services in Cloud. 

IV Laboratory Learning outcome(s) 
            LLO 5.1 Create and Host Web Application. 

 

V Relevant Affective Domain Related Outcomes 

Demonstrate curiosity and enthusiasm towards learning cloud-based web deployment 

and also shows responsibility in managing and hosting applications on cloud platforms. 

 

VI       Relevant Theoretical Background 
Creating and hosting a simple web application on Google Cloud or any cloud platform 

involves understanding the fundamentals of cloud computing, including service models 

like IaaS, PaaS, and SaaS, as well as deployment models such as public, private, and 

hybrid clouds. It requires knowledge of web technologies such as HTML, CSS, 

JavaScript, and client-server architecture, along with an understanding of 

HTTP/HTTPS protocols. Familiarity with cloud-specific services like Google App 

Engine, Compute Engine, or similar offerings from AWS or Azure is essential for 

deploying applications. Additionally, concepts of virtual machines, containers, cloud 

storage, and databases provide the foundation for hosting scalable and reliable 

applications. Understanding version control and basic DevOps practices can further 

enhance the development and deployment process. 

 

 Steps to create and host simple web application 

1. Prepare Your Web Application 

 Create a simple web app using HTML, CSS, JavaScript, or a framework like 

Flask, Node.js, etc. 

 Test it locally to ensure it's working as expected. 

2. Create a Cloud Account 

 Sign up for a Google Cloud account (or AWS, Azure, etc.). 

 Activate the free trial or billing account to access services. 

3. Create a New Project 

 In the cloud console, create a new project for your application. 

4. Set Up Cloud Environment 

 Enable relevant APIs e.g., App Engine, Compute Engine, Cloud Storage. 
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 Install Google Cloud SDK on your local machine.  

 

5. Deploy Using One of the Following Services: 

Option A: Google App Engine (PaaS) 

 Create an app.yaml file specifying runtime (e.g., python39). 

 Deploy using: 

gcloud app deploy 

                              Access the app via the generated URL. 

Option B: Compute Engine (IaaS) 

 Create a virtual machine. 

 Upload your web app files. 

 Install a web server (e.g., Apache, Nginx). 

 Start the server and configure the firewall to allow HTTP traffic. 

Option C: Cloud Storage (Static Website Hosting) 

 Upload static files (HTML, CSS, JS) to a Cloud Storage bucket. 

 Set the bucket as public and configure it for website hosting. 

6. Test and Access the App 

 Visit the provided URL (App Engine or static site) or public IP (Compute 

Engine) to verify hosting. 

7. Optional Enhancements 

 Connect a custom domain. 

 Set up HTTPS (SSL/TLS). 

 Monitor using Cloud Monitoring tools. 

VII Resources required (Additional) 
 

Sr. 

No. 

Name of Resource    Specification Quanti

ty 

Remarks 

(If any) 

1. Code Editor Visual Studio Code, 

Sublime Text, Atom 

 

 

 

2. Cloud Account Google Cloud / AWS / 

Azure with free tier or 

billing setup 

             

 

 

VIII Precautions to be followed 

  1. Follow precautionary measures. 

        2. Follow naming conventions. 

        3. Follow ethical practices. 

 

             IX   Conclusion 

 

…………………………………………………………………………………………………

…………………………………………………………………………………………………

………………………………………………………………………………………………… 

………………………………………………………………………………………………… 

………………………………………………………………………………………………… 
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             X    Practical related Questions 

        Note: Below given are few sample questions for reference. Teachers must design more   

                 such questions to ensure the achievement of identified CO. 

1. Create a basic web page using HTML that displays your name, department, and a 

welcome message. Save it as index.html. 

2. Access the hosted application URL from your browser and take a screenshot of the 

output.  

3. What are the permissions required to make a file publicly accessible on Google Cloud 

Storage? 

(Space for Answer) 

…………………………………………………………………………………………………

…………………………………………………………………………………………………

…………………………………………………………………………………………………

…………………………………………………………………………………………………
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………………………………………………………………………………………………… 

…………………………………………………………………………………………………

…………………………………………………………………………………………………

…………………………………………………………………………………………………

…………………………………………………………………………………………………

………………………………………………………………………………………………… 

…………………………………………………………………………………………………

…………………………………………………………………………………………………

…………………………………………………………………………………………………

…………………………………………………………………………………………………

………………………………………………………………………………………………… 

…………………………………………………………………………………………………

…………………………………………………………………………………………………

…………………………………………………………………………………………………

……………………………………………………………………………………………….. 
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          XI References / Suggestions for further Reading 

1. https://cloud.google.com/storage/docs/hosting-static-website 

2. https://cloud.google.com/appengine/docs/standard 

3. https://cloud.google.com/sdk/docs/install 

4. https://docs.aws.amazon.com/AmazonS3/latest/userguide/WebsiteHosting.html 

 

 

XII Assessment Scheme 

            The given performance indicators should serve as a guideline for assessment 

regarding process and product related marks. Faculty must fill only the table at 

bottom. 

Performance indicators Weightage 

Process related (15 Marks) 70% 

1  Logic formation 30% 

2  Debugging ability 30% 

3  Follow ethical practices 10% 

Product related (10 Marks) 30% 

4  Expected output 10% 

5  Timely Submission 10% 

6  Answer to sample questions 10% 

 Total (25 Marks) 100% 

 

 

 

 

 

 

  

              

 

 

 

  

  

 

 

 

 

 

 

 

 

 

 

 

 

  

Marks Obtained 
Dated signature of 

Teacher 

Process 

Related 

(15) 

Product 

Related 

(10) 

Total 

(25) 
 

   

https://cloud.google.com/storage/docs/hosting-static-website
https://cloud.google.com/appengine/docs/standard
https://cloud.google.com/sdk/docs/install
https://docs.aws.amazon.com/AmazonS3/latest/userguide/WebsiteHosting.html
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Practical No. 6: Configure Cloud using JustCloud 

 
I         Practical Significance 

             Apache Hadoop's HDFS (Hadoop Distributed File System) is an essential part. It 

guarantees excellent efficiency and data dependability while enabling the storage of 

big datasets across remote computers. Since many cloud storage solutions in actual 

distributed cloud settings operate on similar concepts, it is important to understand 

HDFS. 

  

II Industry/Employer Expected outcome(s) 
   Manage Cloud based services. 

 

III Course Level Learning outcome(s) 

  CO3 - Maintain storage system and services in Cloud. 

 

IV Laboratory Learning outcome(s) 
            LLO 6.1 Create a File system on Cloud. 

 

V Relevant Affective Domain Related Outcomes 

Demonstrates discipline in executing the steps of HDFS installation and usage in a 

systematic manner  

 

VI       Relevant Theoretical Background 

 HDFS: 

 A file system called HDFS was created to function on common hardware.  Its 

architecture is master/slave, with: 

  NameNode: Controls the file system's metadata. 

  DataNodes: Hold the actual parts of data. 

 Important attributes: 

1. Excellent fault tolerance 

2. Ideal for uses involving big data sets 

3. The "write once, read often" pattern 

4. chunks of data are stored (by default, 128 MB). 

 HDFS Structure 

- /user/hadoop/input 

- /user/hadoop/output 

 Steps 

Step 1: Install Java 

- sudo apt update 

- sudo apt install openjdk-8-jdk -y 

- java -version 

Step 2: Download and Extract Hadoop 

- wget https://downloads.apache.org/hadoop/common/hadoop-3.3.6/hadoop-

3.3.6.tar.gz 

- tar -xvzf hadoop-3.3.6.tar.gz 

- sudo mv hadoop-3.3.6 /usr/local/Hadoop 

 

Step 3: Configure Hadoop Environment Variables 

- export HADOOP_HOME=/usr/local/Hadoop 

https://downloads.apache.org/hadoop/common/hadoop-3.3.6/hadoop-3.3.6.tar.gz
https://downloads.apache.org/hadoop/common/hadoop-3.3.6/hadoop-3.3.6.tar.gz
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- export PATH=$PATH:$HADOOP_HOME/bin:$HADOOP_HOME/sbin 

Reload: 

- source ~/.bashrc 

Step 4: Edit Configuration Files 

4.1. core-site.xml 

<configuration> 

  <property> 

    <name>fs.defaultFS</name> 

    <value>hdfs://localhost:9000</value> 

  </property> 

</configuration> 

4.2. hdfs-site.xml 

<configuration> 

  <property> 

    <name>dfs.replication</name> 

    <value>1</value> 

  </property> 

  <property> 

    <name>dfs.namenode.name.dir</name> 

    <value>file:///usr/local/hadoop/hadoop_data/hdfs/namenode</value> 

  </property> 

  <property> 

    <name>dfs.datanode.data.dir</name> 

    <value>file:///usr/local/hadoop/hadoop_data/hdfs/datanode</value> 

  </property> 

</configuration> 

     Step 5: Format the HDFS Filesystem 

- hdfs namenode -format 

Step 6: Start Hadoop Services 

- start-dfs.sh 

Check running Java processes: 

- jps 

     Step 7: Create Directories in HDFS 

- hdfs dfs -mkdir /user 

- hdfs dfs -mkdir /user/hadoop 

VII Resources required (Additional) 

Sr.No Name of 

Resource 

Broad Specification Quantity Remrks(If any) 

1. Hadoop  Hadoop 2.x 1 Internet for package installation 

 

VIII Precautions to be followed 

 1. Follow precautionary measures. 

       2. Follow naming conventions. 

       3. Follow ethical practices. 

 

             IX    Conclusion 

             ……………………………………………………………………………………………….. 

…………………………………………………………………………………………………

………………………………………………………………………………………………… 

            ……………………………………………………………………………………………….. 
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             X    Practical related Questions 

        Note: Below given are few sample questions for reference. Teachers must design more        

                 such questions to ensure the achievement of identified CO. 

       1. What is the role of the NameNode and DataNode? 

      2. How does HDFS handle fault tolerance? 

      3. Why does HDFS use large block sizes? 

    

(Space for Answer) 
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…………………………………………………………………………………………………… 

                    XI References / Suggestions for further Reading 

1. https://www.digitalregenesys.com/blog/what-is-hadoop-in-cloud-computing 

2. https://www.databricks.com/glossary/hadoop-distributed-file-system-hdfs 

3. https://cloud.google.com/learn/what-is-hadoop 

 

                  XII Assessment Scheme 

             The given performance indicators should serve as a guideline for assessment 

regarding process and product related marks. Faculty must fill only the table at 

bottom. 

 

Performance indicators Weightage 

Process related (15 Marks) 70% 

1  Logic formation 30% 

2  Debugging ability 30% 

3  Follow ethical practices 10% 

Product related (10 Marks) 30% 

4  Expected output 10% 

5  Timely Submission 10% 

6  Answer to sample questions 10% 

 Total (25 Marks) 100% 
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Total 

(25) 
 

   

https://www.digitalregenesys.com/blog/what-is-hadoop-in-cloud-computing
https://www.databricks.com/glossary/hadoop-distributed-file-system-hdfs
https://cloud.google.com/learn/what-is-hadoop
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Practical No. 7: Work in Codenvy to show Provisioning and Scaling of a 

website 
I Practical Significance 

To create a workspace platform for cloud-based development using Codenvy and 

demonstrate provisioning and scaling of a website. 

  

II Industry/Employer Expected outcome(s) 

   Manage Cloud based services. 

III Course Level Learning outcome(s) 

  CO3 - Maintain storage system and services in Cloud. 

 

IV Laboratory Learning outcome(s) 
            LLO 7.1 Create a workspace platform for development. 

 

V Relevant Affective Domain Related Outcomes 

Demonstrates curiosity and interest in exploring cloud-based development tools and 

environments.  

 

VI       Relevant Theoretical Background 

Using a web browser on any device, developers can create, build, and debug 

programs using Codenvy, a cloud-based integrated development environment (IDE). 

It facilitates automatic provisioning, collaborative coding, and application and 

development workspace capacity. 

 Procedure: 

1. Sign Up / Log In to Codenvy 

 Navigate to https://www.eclipse.org/codenvy/ after opening the 

browser. 

 Click on Get Started or Sign Up and create a free account or log in if you 

already have one. 

2. Create a New Workspace 

 After logging in, click on Create Workspace. 

 Choose a stack/template (e.g., Node.js, Java, Python) for your project. 

 Name your workspace (e.g., MyFirstWorkspace) and click Create. 

3. Explore the IDE 

 The online IDE interface will load, showing the file explorer, editor, 

terminal, and other tools. 

 Create or upload project files (HTML, CSS, JavaScript for a simple 

website). 

4. Provisioning the Workspace 

 Click on the Run button to start the workspace environment. 

 Codenvy provisions the necessary container resources automatically in the 

cloud. 

5. Run the Application 

 Use the built-in terminal to run your web application (e.g., npm start for 

Node.js). 
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 Open the preview or the application URL to see your website live. 

6.  Scaling (Conceptual) 

 While Codenvy does not provide manual scaling options in the free tier, 

discuss the concept of provisioning additional containers to handle 

increased workload. 

 Mention how enterprise solutions automate scaling by adding more 

workspace instances or increasing resources dynamically. 

7.  Stop and Delete Workspace 

 After completion, stop the workspace to free cloud resources. 

 Delete the workspace to clean up your account. 

 

VII Resources required (Additional) 

Sr.No Name of 

Resource 

Broad 

Specification 

Quantity Remrks(If any) 

1. Codenvy Codenvy IDE 1 - 

2. GitHub GitHub/Docker 

CLI 

1 - 

 

VIII Precautions to be followed 

 1. Follow precautionary measures. 

       2. Follow naming conventions. 

       3. Follow ethical practices. 

 

            IX   Conclusion 

 

…………………………………………………………………………………………………

…………………………………………………………………………………………………

…………………………………………………………………………………………… 

 

            X    Practical related Questions 

        Note: Below given are few sample questions for reference. Teachers must design more        

                  such questions to ensure the achievement of identified CO. 
       1. How do you start and stop a workspace in Codenvy? 

      2. Mention any challenges you faced during this practical and how you resolved them. 

      3. How does Codenvy provision resources for your application? 

    

                                               (Space for Answer) 

……………………………………………………………………………………………………

……………………………………………………………………………………………………

……………………………………………………………………………………………………

…………………………………………………………………………………………………… 

……………………………………………………………………………………………………

……………………………………………………………………………………………………

……………………………………………………………………………………………………

…………………………………………………………………………………………………… 

……………………………………………………………………………………………………

……………………………………………………………………………………………………

……………………………………………………………………………………………………
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…………………………………………………………………………………………………… 

……………………………………………………………………………………………………

……………………………………………………………………………………………………

……………………………………………………………………………………………………

…………………………………………………………………………………………………… 

……………………………………………………………………………………………………

……………………………………………………………………………………………………

……………………………………………………………………………………………………

…………………………………………………………………………………………………… 

 

           XI References / Suggestions for further Reading 

     1. https://blog.codenvy.com/release-notes-codenvy-5-367a8f1dd802 

     2. https://www.eclipse.org/codenvy/ 

 

          XII Assessment Scheme 

        The given performance indicators should serve as a guideline for assessment regarding 

process and product related marks. Faculty must fill only the table at bottom. 

 

Performance indicators Weightage 

Process related (15 Marks) 70% 

1  Logic formation 30% 

2  Debugging ability 30% 

3  Follow ethical practices 10% 

Product related (10 Marks) 30% 

4  Expected output 10% 

5  Timely Submission 10% 

6  Answer to sample questions 10% 

 Total (25 Marks) 100% 

 

 

 

  

              

 

 

 

  

  

 

 

  

Marks Obtained 
Dated signature of 

Teacher 

Process 

Related(15) 

Product 

Related(10) 

Total 

(25) 
 

   

https://www.eclipse.org/codenvy/
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Practical No. 8: Implement Identity Management and Access Management 

using OpenStack 

 
I      Practical Significance 

           To monitor user access and permissions in a cloud environment by implementing 

identity and access management (IAM) using OpenStack services. 

 

II Industry/Employer Expected outcome(s) 

    Manage Cloud based services. 

 

III Course Level Learning outcome(s) 
  CO4 - Apply Security in Cloud Computing. 

 

IV Laboratory Learning outcome(s) 

LLO 8.1 Implement Identity Management and Access Management using Cloud 

computing infrastructure. 

 

V Relevant Affective Domain Related Outcomes 

To implement Identity and Access Management (IAM) in OpenStack using Keystone 

service to manage users, roles, and permissions. 

 

VI       Relevant Theoretical Background 

OpenStack Keystone is the identity service used for authentication and high-level 

authorization. It provides: 

 User authentication 

 Role-based access control (RBAC) 

 Service catalog management 

IAM in OpenStack is like user permission management. It lets admins create users, assign 

roles, and allow or restrict access to services like Nova, Glance, Neutron, etc. 

Important terms: 

 Tenant/Project: Group of users (like departments). 

 Role: Defines what a user can do. 

 User: Person accessing services. 

 Service: OpenStack components (e.g., Nova = compute). 

 

 One essential function of cloud platforms is Identity and Access Management (IAM), 

which establishes who has access to what resources and how. The Keystone service, 

which manages user authentication, role assignments, projects (tenants), and secure 

access control policies, is in charge in OpenStack. 

Procedure: 

 Login to OpenStack Dashboard (Horizon) or access terminal as admin.  

 

 Create a new Project (Tenant) 

 openstack project create myproject --domain default 

 

 Create a new User 

 openstack user create --domain default --password-prompt myuser 
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 Assign Role to User in a Project 

 openstack role add --project myproject --user myuser member 

 

 Verify Role Assignment 

 openstack role assignment list --user myuser --project myproject –names 

 

 Try Logging in with the New User 

 Open the OpenStack Horizon Dashboard in a browser. 

 Log in with the newly created user credentials. 

 

 

VII Resources required (Additional) 

Sr.No Name of 

Resource 

Broad 

Specification 

Quantity Remrks(If any) 

1. OpenStack OpenStack 

DevStack 

1  - 

2. PC PC with 16GB+ 

RAM 

1 - 

 

VIII Precautions to be followed 

 1. Follow precautionary measures. 

       2. Follow naming conventions. 

       3. Follow ethical practices. 

 

           IX   Conclusion 

             ……………………………………………………………………………………………….  

…………………………………………………………………………………………………

……………………………………………………………………………………………….. 

 

           X    Practical related Questions 

        Note: Below given are few sample questions for reference. Teachers must design more     

               such questions to ensure the achievement of identified CO. 

1. Can you give an example of when role-based access would be critical in a real-world         

 cloud system? 

      2. What is the purpose of the --domain flag in the user creation command? 

      3. Which command is used to create a user in OpenStack?    

      4. What is Horizon in OpenStack, and how is it used for IAM? 

 

(Space for Answer) 

……………………………………………………………………………………………………

……………………………………………………………………………………………………

……………………………………………………………………………………………………

…………………………………………………………………………………………………… 

……………………………………………………………………………………………………

……………………………………………………………………………………………………

……………………………………………………………………………………………………

…………………………………………………………………………………………………… 

……………………………………………………………………………………………………

……………………………………………………………………………………………………

……………………………………………………………………………………………………
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…………………………………………………………………………………………………… 

……………………………………………………………………………………………………

……………………………………………………………………………………………………

……………………………………………………………………………………………………

…………………………………………………………………………………………………… 

……………………………………………………………………………………………………

……………………………………………………………………………………………………

……………………………………………………………………………………………………

…………………………………………………………………………………………………… 

……………………………………………………………………………………………………

……………………………………………………………………………………………………

……………………………………………………………………………………………………

…………………………………………………………………………………………………… 

……………………………………………………………………………………………………

……………………………………………………………………………………………………

……………………………………………………………………………………………………

…………………………………………………………………………………………………… 

……………………………………………………………………………………………………

…………………………………………………………………………………………………… 

 

            XI References / Suggestions for further Reading 

1. https://docs.openstack.org/newton/admin-guide/identity-management.html 

2.https://docs.redhat.com/en/documentation/red_hat_openstack_platform/16.0/html/se

curity_and_hardening_guide/identity_and_access_management 

 

          XII Assessment Scheme 

           The given performance indicators should serve as a guideline for assessment regarding 

process and product related marks. Faculty must fill only the table at bottom. 

 

Performance indicators Weightage 

Process related (15 Marks) 70% 

1  Logic formation 30% 

2  Debugging ability 30% 

3  Follow ethical practices 10% 

Product related (10 Marks) 30% 

4  Expected output 10% 

5  Timely Submission 10% 

6  Answer to sample questions 10% 

 Total (25 Marks) 100% 

 

 

 

 

  

              

 

 

 

  

Marks Obtained 
Dated signature of 

Teacher 

Process 

Related(15) 

Product 

Related(10) 

Total 

(25) 
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Practical No. 9: Configure Server using CFEngine or any other open-

source tool 
I       Practical Significance 

To configure and automate server management tasks using CFEngine (or an 

equivalent configuration management tool like Ansible, Puppet, or Chef).  

 

II Industry/Employer Expected outcome(s) 

   Manage Cloud based services. 

 

III Course Level Learning outcome(s) 
  CO4 - Apply Security in Cloud Computing. 

IV Laboratory Learning outcome(s) 
            LLO 9.1 Configure server for security. 

 

V Relevant Affective Domain Related Outcomes 

Manual server configuration is prone to mistakes. Configuration management tools 

ensure that systems remain in a consistent state. 

 

VI       Relevant Theoretical Background 

            CFEngine is an open-source configuration management tool that automates the 

configuration and maintenance of servers. It uses policy files to define desired 

system states and ensures systems comply with those policies. 

  Procedure using CFEngine: 

 Step 1: Install CFEngine on your system 

 sudo apt update 

wget https://cfengine.com/pub/gpg.key 

sudo apt-key add gpg.key 

echo "deb https://cfengine.com/pub/deb/ stable main" | sudo tee 

/etc/apt/sources.list.d/cfengine-community.list 

sudo apt update 

sudo apt install cfengine-community 

Step 2: Verify installation 

 cf-agent --version 

Step 3: Create a simple policy file 

 Create a file called hello.cf with this content: 

body common control { 

   bundlesequence => { "main" }; 

} 

bundle agent main { 

   reports: 

     "Hello from CFEngine!"; 

} 

Step 4: Run the policy 

 sudo cf-agent -f ./hello.cf 

Step 5: Observe output 

 R: Hello from CFEngine! 

https://cfengine.com/pub/gpg.key
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VII Resources required (Additional) 
 

Sr.No Name of 

Resource 

Broad 

Specification 

Quantity Remrks(If any) 

1. CFEngine CFEngine 1 - 

 

 

VIII Precautions to be followed 

 1. Follow precautionary measures. 

       2. Follow naming conventions. 

       3. Follow ethical practices. 

 

           IX   Conclusion 

             ………………………………………………………………………………………………..   

…………………………………………………………………………………………………

……………………………………………………………………………………………….. 

 

           X    Practical related Questions 

        Note: Below given are few sample questions for reference. Teachers must design more  

                 such questions to ensure the achievement of identified CO. 
       1. How do you install CFEngine on Ubuntu?? 

      2. What is the role of cf-agent? 

      3. How do you run a CFEngine policy file 

    

(Space for Answer) 

…..………………………………………………………………………………………………

……………………………………………………………………………………………………

……………………………………………………………………………………………………

……………………………………………………………………………………………………

…………………………………………………………………………………………………… 

…………………………………………………………………………………………………

……………………………………………………………………………………………………

……………………………………………………………………………………………………

……………………………………………………………………………………………………

………………………………………………………………………………………………… 

…………………………………………………………………………………………………

……………………………………………………………………………………………………

…………………………………………………………………………………………………… 

…………………………………………………………………………………………………

……………………………………………………………………………………………………

…………………………………………………………………………………………………… 

…..………………………………………………………………………………………………

……………………………………………………………………………………………………

……………………………………………………………………………………………………

……………………………………………………………………………………………………

…………………………………………………………………………………………………… 

…………………………………………………………………………………………………

……………………………………………………………………………………………………

……………………………………………………………………………………………………

………………………………………………………………………………………………… 
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           XI References / Suggestions for further Reading 

      1. https://cfengine.com/ 

      2. https://www.techtarget.com/searchitoperations/feature/CFEngine-configuration-    
 

 

             XII Assessment Scheme 

         The given performance indicators should serve as a guideline for assessment regarding 

process and product related marks. Faculty must fill only the table at bottom. 

 

Performance indicators Weightage 

Process related (15 Marks) 70% 

1  Logic formation 30% 

2  Debugging ability 30% 

3  Follow ethical practices 10% 

Product related (10 Marks) 30% 

4  Expected output 10% 

5  Timely Submission 10% 

6  Answer to sample questions 10% 

 Total (25 Marks) 100% 

 

 

 

 

  

              

 

 

 

  

  

 

 

 

 

 

  

Marks Obtained 
Dated signature of 

Teacher 

Process 

Related(15) 

Product 

Related(10) 

Total 

(25) 
 

   

https://www.techtarget.com/searchitoperations/feature/CFEngine-configuration-%20%20%20management-tool-up-close-and-in-depth
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Practical No. 10: Design an application based on IoT using Arduino or 

Raspberry Pi. 
I        Practical Significance 

To design and implement an IoT-based application using Arduino or Raspberry 

Pi for collecting sensor data and controlling devices. 

 

II Industry/Employer Expected outcome(s) 

   Manage Cloud based services. 

 

III Course Level Learning outcome(s) 
  CO5 - Use various Cloud Platforms. 

IV Laboratory Learning outcome(s) 
            LLO 10.1 Design IoT based application. 

 

V Relevant Affective Domain Related Outcomes 

Demonstrates how sensors, microcontrollers, and networks form IoT solutions. 

 

VI       Relevant Theoretical Background 
            Internet of Things (IoT) is a system of interrelated devices connected via the Internet 

that can collect, send, and act on data. In this practical, we use a microcontroller 

(Arduino) or a microprocessor (Raspberry Pi) to: 

 Read data from sensors. 

 Process or transmit the data. 

 Control actuators (like turning on an LED or fan). 

              This forms a basic IoT application. 

 Procedure (Using Arduino + DHT11 Example) 

Step 1: Connect the Components Wiring for DHT11 with Arduino: 

 VCC → 5V on Arduino 

 GND → GND 

 Data → Digital Pin 2 

 (Use 10kΩ resistor between VCC and Data line if needed) 

Step 2: Install Arduino IDE & Libraries 

 Install Arduino IDE 

 Install DHT sensor library: 

o Go to Sketch > Include Library > Manage Libraries 

o Search for "DHT sensor library" by Adafruit and install it. 

Step 3: Write & Upload Code 

#include "DHT.h" 

 

#define DHTPIN 2     // Digital pin connected to the sensor 

#define DHTTYPE DHT11   // DHT11 or DHT22 

 

DHT dht(DHTPIN, DHTTYPE); 

 

void setup() { 

  Serial.begin(9600); 

  dht.begin(); 

} 
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void loop() { 

  float temp = dht.readTemperature(); 

  float hum = dht.readHumidity(); 

 

  if (isnan(temp) || isnan(hum)) { 

    Serial.println("Failed to read from DHT sensor!"); 

    return; 

  } 

 

  Serial.print("Temperature: "); 

  Serial.print(temp); 

  Serial.print(" °C, Humidity: "); 

  Serial.print(hum); 

  Serial.println(" %"); 

 

  delay(2000); // Wait for 2 seconds 

} 

 

 Step 4: View Serial Output 

 Open Serial Monitor in Arduino IDE 

 Observe live temperature and humidity readings 

Step 5 (Optional): Send Data to Cloud Platform 

 Use Wi-Fi Module (e.g., ESP8266 with Arduino or inbuilt Wi-Fi on Raspberry Pi) 

 Send sensor data to cloud platforms like: 

o ThingSpeak (via HTTP) 

o Firebase 

o Blynk (for mobile control) 

 

VII Resources required (Additional) 
 

Sr.No Name of 

Resource 

Broad 

Specification 

Quantity Remrks(If any) 

1. Device/ 

Arduino 

Arduino Uno / 

Raspberry 

Pi,Sensors 

(temperature, 

IR, etc.) 

1 - 

 

VIII Precautions to be followed 

 1. Follow precautionary measures. 

       2. Follow naming conventions. 

       3. Follow ethical practices. 

 

              IX   Conclusion 

 

…………………………………………………………………………………………………

…………………………………………………………………………………………………

………………………………………………………………………………………………….. 
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         X    Practical related Questions 

        Note: Below given are few sample questions for reference. Teachers must design more  

                 such questions to ensure the achievement of identified CO. 
       1. What library is required to interface DHT11 with Arduino? 

      2. What is the role of delay(2000); in the loop? 

      3. What precautions do you take while powering the Arduino/Raspberry Pi? 

      4. Which pin did you use for sensor input, and why? 

    

(Space for Answer) 

…………………………………………………………………………………………………

……………………………………………………………………………………………………

……………………………………………………………………………………………………

……………………………………………………………………………………………………

…………………………………………………………………………………………………… 

…………………………………………………………………………………………………

……………………………………………………………………………………………………

……………………………………………………………………………………………………

…………………………………………………………………………………………………… 

…………………………………………………………………………………………………

……………………………………………………………………………………………………

……………………………………………………………………………………………………

………………………………………………………………………………………………….. 

…………………………………………………………………………………………………

……………………………………………………………………………………………………

……………………………………………………………………………………………………

………………………………………………………………………………………………….. 

…………………………………………………………………………………………………

……………………………………………………………………………………………………

……………………………………………………………………………………………………

…………………………………………………………………………………………………… 

…………………………………………………………………………………………………

……………………………………………………………………………………………………

……………………………………………………………………………………………………

………………………………………………………………………………………………… 

…………………………………………………………………………………………………

……………………………………………………………………………………………………

……………………………………………………………………………………………………

…………………………………………………………………………………………………… 

…………………………………………………………………………………………………

……………………………………………………………………………………………………

……………………………………………………………………………………………………

…………………………………………………………………………………………………… 

…………………………………………………………………………………………………

……………………………………………………………………………………………………

……………………………………………………………………………………………………

…………………………………………………………………………………………………… 

…………………………………………………………………………………………………

…………………………………………………………………………………………………… 

…………………………………………………………………………………………………

…………………………………………………………………………………………………… 
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            XI References / Suggestions for further Reading 

 

1. IoT Projects and Tutorials using Arduino, Raspberry Pi, ESP8266 & NodeMCU 

2. Top 6 Smart & Simple IOT Projects 2021 Using Arduino & Raspberry Pi 

3. IoT Design and Simulation - Arduino and Raspberry Pi - Proteus 

 

XII Assessment Scheme 

           The given performance indicators should serve as a guideline for assessment regarding 

process and product related marks. Faculty must fill only the table at bottom. 

 

Performance indicators Weightage 

Process related (15 Marks) 70% 

1  Logic formation 30% 

2  Debugging ability 30% 

3  Follow ethical practices 10% 

Product related (10 Marks) 30% 

4  Expected output 10% 

5  Timely Submission 10% 

6  Answer to sample questions 10% 

 Total (25 Marks) 100% 

 

 

 

 

 

 

 

 

 

 

  

  

Marks Obtained 
Dated signature of 

Teacher 

Process 

Related(15) 

Product 

Related(10) 

Total 

(25) 
 

   

https://iotdesignpro.com/iot-projects
https://nevonprojects.com/top-6-smart-simple-iot-projects-on-arduino-raspberry-pi/
https://www.labcenter.com/iotbuilder/
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Practical No. 11: Design any automated application using RFID 

I      Practical Significance 

            To design and implement an automated application using RFID technology 

integrated with a cloud platform for data monitoring and analysis. 

 

II Industry/Employer Expected outcome(s) 

   Manage Cloud based services. 

 

III Course Level Learning outcome(s) 
  CO5 - Use various Cloud Platforms. 

IV Laboratory Learning outcome(s) 
            LLO 11.1 Design Cloud based application. 

 

V Relevant Affective Domain Related Outcomes 

An automated RFID-based application that logs data to a cloud platform. This 

demonstrates real-time data acquisition and monitoring using IoT and Cloud 

Computing integration.  

 

VI       Relevant Theoretical Background 
 RFID (Radio Frequency Identification) is a wireless tracking system that uses radio 

signals to identify and track tags attached to objects. Each RFID tag contains a unique 

ID. 

This experiment integrates RFID with a cloud platform to store and analyze data in real-

time. When an RFID tag is scanned, the data (tag ID and timestamp) is sent to the cloud 

for logging or triggering automated actions like attendance marking or access control. 

Procedure: 

1. Hardware Setup: 

Connect the RFID reader to the Arduino or Raspberry Pi. 

Example (for Arduino + RC522): 

SDA → D10 

SCK → D13 

MOSI → D11 

MISO → D12 

RST → D9 

GND → GND 

3.3V → 3.3V 

2. Code Development: 

 Install necessary libraries (e.g., MFRC522, SPI) in Arduino IDE. 

 Write code to read tag ID. 

 Integrate cloud functionality using services like: 

 Firebase: via ESP8266/ESP32 

 ThingSpeak: via HTTP requests 

 Google Sheets: via IFTTT + Webhooks 

 

3. Sample Arduino Code Snippet (RFID Read): 

#include <SPI.h> 

#include <MFRC522.h> 
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#define SS_PIN 10 

#define RST_PIN 9 

MFRC522 rfid(SS_PIN, RST_PIN); 

 

void setup() { 

  Serial.begin(9600); 

  SPI.begin(); 

  rfid.PCD_Init(); 

  Serial.println("Scan RFID tag..."); 

} 

 

void loop() { 

  if (!rfid.PICC_IsNewCardPresent()) return; 

  if (!rfid.PICC_ReadCardSerial()) return; 

  Serial.print("Tag ID: "); 

  for (byte i = 0; i < rfid.uid.size; i++) { 

    Serial.print(rfid.uid.uidByte[i], HEX); 

  } 

  Serial.println(); 

  delay(1000); 

} 

 

VII Resources required (Additional) 

Sr.No Name of 

Resource 

Broad 

Specification 

Quantity Remrks(If any) 

1. IDE Arduino IDE 1 - 

 

VIII Precautions to be followed 

 1. Follow precautionary measures. 

       2. Follow naming conventions. 

       3. Follow ethical practices. 

 

             IX   Conclusion 

 

…………………………………………………………………………………………………

…………………………………………………………………………………………………

…………………………………………………………………………………………………

…………………………………………………………………………………………………

………………………………………………………………………………………………… 

 

                X    Practical related Questions 

        Note: Below given are few sample questions for reference. Teachers must design more     

                  such questions to ensure the achievement of identified CO. 

       1. Which libraries are required to work with the RC522 module in Arduino IDE? 

      2. How do you connect the RFID system to a cloud platform? 

      3. What are webhooks and how are they used to send data to Google Sheets? 

    

(Space for Answer) 

 

…………………………………………………………………………………………………
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…………………………………………………………………………………………………

…………………………………………………………………………………………………

…………………………………………………………………………………………………

………………………………………………………………………………………………… 
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           XI References / Suggestions for further Reading 

1. https://smartmakers.io/en/rfid-anwendungen-in-verschiedenen-branchen/ 

2. https://how2electronics.com/rfid-technology-design-types-working-applications/ 

 

         XII Assessment Scheme 

             The given performance indicators should serve as a guideline for assessment 

regarding process and product related marks. Faculty must fill only the table at 

bottom. 

 

Performance indicators Weightage 

Process related (15 Marks) 70% 

1  Logic formation 30% 

2  Debugging ability 30% 

3  Follow ethical practices 10% 

Product related (10 Marks) 30% 

4  Expected output 10% 

5  Timely Submission 10% 

6  Answer to sample questions 10% 

 Total (25 Marks) 100% 

 

 

 

 

 

 

  

              

 

Marks Obtained 
Dated signature of 

Teacher 

Process 

Related(15) 

Product 

Related(10) 

Total 

(25) 
 

   

https://smartmakers.io/en/rfid-anwendungen-in-verschiedenen-branchen/
https://how2electronics.com/rfid-technology-design-types-working-applications/
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